
RELEASE NOTES FOR NUKE 5.2v1
his is a major new release of Nuke with many new features, improvements and
bug fixes.

5.2v1

Version
Nuke 5.2v1

Release Date
27 August 2009

Supported Operating Systems

• Mac OS X 10.5 “Leopard” (32-bit only)

• Windows XP SP2, XP64

• Linux CentOS 4.5 (32- and 64-bit)

New Features

• Metadata
Nuke now passes image metadata down the node tree. There is a MetaData menu in the 
Toolbar with five new nodes:

• ViewMetaData lets you inspect the metadata passed down by the input node.

• CompareMetaData lets you compare the metadata between two inputs and view the 
differences. 

• ModifyMetaData lets you edit existing metadata in the input stream, add metadata into 
the stream, and delete metadata from the stream.

• CopyMetaData lets you copy metadata from one input to another and filter metadata to 
exclude some of it.

• AddTimeCode lets you add a timecode to the metadata passed down by the input node.

The following file format writers have been updated to support metadata output: EXR, CIN, 
DPX, and JPEG. When writing metadata to an EXR file, you can use the metadata menu in the 
Write node controls to specify what to write out, since arbitrary header fields are supported 
by EXR files. When writing any other image file format, Nuke writes whatever metadata the 
file format header is known to support.

Metadata can also be accessed via TCL expressions and Python.
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For more information, see Working with File Metadata on page 123 of the User Guide and 
Accessing Node Metadata on page 431.

• Precomp Node
The Other menu in the Toolbar now includes a Precomp node. A Precomp node is essen-
tially just a group, but the content is stored in an independent .nk file. This means you can 
save a subset of the node tree as a separate .nk script, render the output of this saved 
script, and read the rendered output back into the main comp as a single image input.

Precomp nodes can be useful in at least two ways. Firstly, they can be used to reduce por-
tions of the node tree to pre-rendered image inputs. This speeds up render time. Secondly, 
Precomp nodes enable a collaborative workflow. While one artist works on the main comp, 
others can work on the sections that have been exported using the Precomp node. 
Precomps can also be version-managed by choosing the version of the Precomp .nk file to 
reference in the main comp.

By default, a Precomp .nk file includes a Write node and takes advantage of the new read-
back capability in that node to shortcut around processing the precomped nodes. However, 
the precomped nodes can also be processed if you prefer to work that way.

For more information, see Using the Precomp Node on page 118 of the User Guide.

• DiskCache Node
The Other menu in the Toolbar also includes another new node called the DiskCache node. 
This node caches to disk scanlines from its input as they are requested by its output. This 
can be useful, for example, if you are working on a large, complex node tree, you are read-
ing in images from a network, or you are painting or rotoscoping.

Unlike a Write node, the DiskCache node writes raw data to disk and tracks whether or not 
the written lines are up-to-date with respect to the input nodes that created them, recom-
puting when necessary.

For more information, see Using the DiskCache Node on page 104 of the User Guide.

• Tile Node
The Transform menu in the Toolbar now includes a Tile node. The Tile node produces an 
output image that contains scaled-down, tiled copies of the input image.

For more information, see Replicating the Input Image Across the Output on page 197 of 
the User Guide.

• Monitor Output
To check the final result in correct video colourspace and pixel aspect ratio, you can pre-
view the current Viewer image on an external broadcast video monitor. This option is only 
available in 32- and 64-bit Windows and 32-bit Mac OS X versions of Nuke, and requires 
additional hardware, such as a monitor output card or a FireWire port. Our video output 
architecture on Mac OS X is designed to support any video output card that works as a 
QuickTime Video Output Component - for example, Blackmagic Design DeckLink or AJA 
KONA. We also support Blackmagic Design DeckLink and AJA XENA natively on 32- and 64-
bit Windows.

You can set up, enable, and disable monitor output in the Viewer settings. You can also 
toggle monitor output on and off by clicking on the monitor ouput button in the top right 
corner of the Viewer controls (or by pressing Ctrl/Cmd+U).

GPU processing is disabled whenever monitor output is active.

Note that monitor output is not supported in the Nuke Personal Learning Edition (PLE).

For more information, see Previewing on an External Broadcast Video Monitor on page 382 
of the User Guide.
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• Dockable Progress Panels
The content menus include a dockable Progress panel which you can add to your layout and 
save as part of a layout. Whenever a Progress panel exists in a script, progress bars for 
any active tasks Nuke performs are displayed in the panel. Otherwise, progress bars appear 
in a pop-up dialog.

In addition, new progress functions have been added to the "nuke" Python module. You can 
create a progress task with:

x = nuke.ProgressTask("task title")
then set a message for the current step, update progress, and check to see if the user has 
canceled it.

For more information, see Progress Bars on page 92 of the User Guide and Creating 
Progress Bar Dialogs on page 436. You can also do help(nuke.ProgressTask).

• Input Processes and Viewer Processes
In addition to Input Processes, you can now use Viewer Processes to modify the image 
from the viewed node before it is displayed on your monitor. 

Rather than a node placed in the Node Graph, a Viewer Process is a named node or gizmo 
that the Viewer instantiates as needed. You can register any number of Viewer Processes 
using Python at start-up, have them appear in the Viewer’s Viewer Process menu (the menu 
where display LUTs used to appear), and easily switch between them. Note that Nuke no 
longer adds every LUT in the project settings to this menu so it is necessary to register a 
Viewer Process that uses the ViewerLookup node to apply the LUT you want. There are two 
predefined Viewer Processes, sRGB and rec709. You can also find a number of others in 
your menu.py, but these are commented out by default.

To register a Viewer Process, use the following function in your menu.py:

nuke.ViewerProcess.register()
For example, to register a gizmo called MyProcess.gizmo as a Viewer Process and have it

appear in the Viewer Process menu as My Custom Process, you would enter the following:

nuke.ViewerProcess.register("My Custom Process", nuke.createNode, ("MyProcess",)) 

The older Input Processes also continue to work. For backwards compatability, any node 
named VIEWER_INPUT will automatically be set as an Input Process in the Viewer settings. 
However, you can call the node anything you like and set it as an Input Process by selecting 
Edit > Node > Use as Input Process. Whenever an Input Process is named in the Viewer 
settings, the IP button appears in the Viewer controls and lets you toggle the Input Process 
on and off.

The Viewer settings contain an option for the Input Process to be applied before or after 
the Viewer Process, so the two may be used in conjunction, for instance, with the Input 
Process applying a projection mask after the Viewer Process applies a film look profile.

For more information, see Input Process and Viewer Process Controls on page 83 of the 
User Guide and Creating Custom Viewer Processes on page 489.

• Frame Ranges
You can now define frame ranges in the following ways:

3 expands to 3.

-3 expands to -3.

1 3 4 8 expands to 1, 3, 4, 8.
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1-5 expands to 1, 2, 3, 4, 5.

-3-4 expands to -3, -2, -1, 0, 1, 2, 3, 4

-8--5 expands to -8, -7, -6, -5

1-10×2 expands to 1, 3, 5, 7, 9.

1-10×1 expands to 1, 2, 3, 4, 5, 6, 7, 8, 9, 10.

1-4 8-10 12-14 expands to 1, 2, 3, 4, 8, 9, 10, 12, 13, 14.

For backwards compatability, the old syntax that uses commas rather than hyphens also 
continues to work.

From the command line, you can use the -F flag to use the new syntax.

For more information, see Defining Frame Ranges on page 113 of the User Guide.

• Panalog, RedLog, ViperLog, and REDSpace LUTs
Added Panalog, RedLog, and ViperLog to the built-in set of lookup-tables (LUTs). 

The Panalog LUT is based on a log2lin conversion with a blackpoint of 64, whitepoint of 
681, and a gamma of 0.89.

The REDLog LUT is based on a log2lin conversion with a blackpoint of 0, whitepoint of 
1023, and a gamma of 1.022.

The ViperLog LUT is based on a log2lin conversion with a blackpoint of 0, whitepoint of 
1023, and a gamma of 1.0.

The REDspace LUT is based on a curve provided by RED.

For more information on LUTs, see Altering a Script’s Lookup Tables (LUTs) on page 485 of 
the User Guide.

• REDCODE (.r3d) Files
On 32-bit operating systems, Nuke supports the reading of REDCODE (.r3d) files.

For more information, see Supported File Formats on page 616 of the User Guide.

Note that .r3d files may look different in Nuke compared to various versions of RED appli-
cations, like RED ALERT! or REDCINE. Unlike most other file formats Nuke reads, the .r3d 
REDCODE files must be processed to convert from a raw format to an RGB colour image. 
Because RED have released a newer version of the RED SDK than Nuke uses to improve this 
processing, Nuke is using a different version than the RED applications. Nuke will be 
updated to use the new colour processing in an upcoming release.

• Python Panels
You can now create modal dialogs and non-modal panels from Python using all the Knob 
types available to nodes. These can be invoked at start-up or when the user selects a menu 
item that calls the dialog or panel. Non-modal panels can also be docked into panes and 
saved with window layouts.

The old TCL panels system remains for backwards compatibility but is deprecated. The 
nuke.Panel class (Python wrapper for the TCL panels) is also deprecated and may be 
removed in a future release.

For more information, see Creating Dialogs and Panels on page 431 of the User Guide.

• Python Callbacks
You can define Python callbacks that are executed automatically when various things hap-
pen in Nuke, such as the creation or deletion of nodes, the user changing the controls on 
nodes, and loading and saving scripts. This is done using the new nuke.add...() functions to 
register these callbacks. For many of these functions, there are also knobs with the same 
name (see the list below). 

Here are the available knobs and functions:

• nuke.addOnUserCreate(function)
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• node.knob('onCreate'), nuke.addOnCreate(function)

• root.knob('onScriptLoad'), nuke.addOnScriptLoad(function)

• root.knob('onScriptSave'), nuke.addOnScriptSave(function)

• root.knob('onScriptClose'), nuke.addOnScriptClose(function)

• node.knob('onDestroy'), nuke.addOnDestroy(function)

• node.knob('knobChanged'), nuke.addKnobChanged(function)

• node.knob('updateUI'), nuke.addUpdateUI(function)

• node.knob('autolabel'), nuke.addAutolabel(function)

• write.knob('beforeRender'), nuke.addBeforeRender(function)

• write.knob('beforeFrameRender'), nuke.addBeforeFrameRender(function)

• write.knob('afterFrameRender'), nuke.addAfterFrameRender(function)

• write.knob('afterRender'), nuke.addAfterRender(function)

• nuke.addFilenameFilter(function)

All the add callbacks calls also have a corresponding remove callback call. For example: 
addOnCreate / removeOnCreate.

For more information, see Python Callbacks Embedded in Scripts and Nodes on page 439 of 
the User Guide.

• Stereo FrameCycler
On Windows, Linux, and Mac OS X 10.5 (Leopard) or higher, the bundled FrameCycler has 
been upgraded to a new version with dual stream (stereo) support. This allows you to pre-
view stereo images. To do so, select Render > Flipbook selected and specify the views to 
render in the dialog that opens.

For more information, see Flipbooking Stereoscopic Images within FrameCycler on page 
378 of the User Guide.

• 3D
Added the FillMat node to the 3D > Shader menu. 

The FillMat node fills the selected material colour channels with a constant colour. Typi-
cally, you would use this node to make one object hold out the others. When you set the 
FillMat colour to 0, it acts as a “3D cookie cutter” and makes a black hole where the mate-
rial

would otherwise be.

This is similar to using a black Constant node as the input texture. However, the advantage 
of using the FillMat node is that you can easily apply it to the alpha channel in addition to 
the rgb channels. Another advantage is that the FillMat node doesn’t break the shading 
sequence, so you can insert it after other material nodes in your node tree.

Feature Enhancements

• Viewer

• Playback in the Viewer is greatly improved in a number of situations. Images are loaded 
from the disk cache much faster than before so that realtime playback of 2K images is 
possible (however, very large scripts may be too slow for this). A bug where a frame 
that finished updating in the Viewer was not saved to the disk cache is also fixed, so 
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you get playback after only one cycle through the sequence. Cached images are 
reusable if you change the zoom level or pan the Viewer around.

• In previous versions of Nuke, as you panned from side to side in the Viewer, only the 
visible part of the image was written to cache. As you panned, the new visible area 
overwrote the old one, so that if you panned back to the old area, that area needed to 
be recalculated. Nuke now merges the cached area as you pan, so it does not need to 
be recalculated. This makes panning much faster.

• The refresh button is no longer disabled when the Viewer thinks the image is up-to-
date. You can press it at any time to refresh the image.

• The viewer error display is now drawn at the top of the Viewer agaist a red background 
to make it more visible.

• The default viewer LUT menu in the Project settings has been removed, because it is 
not applicable to the new Viewer Process gizmo system and is redundant, being easily 
replaced with a knob default setting.

To set a Viewer Process gizmo as the default Viewer LUT, add the following entry in 
your init.py file:

# substitute whatever Viewer Process option you like for "rec709"

nuke.knobDefault("Viewer.viewerProcess", "rec709")

• Screen space dithering is now applied in the floating point Viewer display modes (when 
bit depth in Viewer settings is other than byte) to reduce the appearance of banding 
that is not present in the rendered floating point image data, similar to the way the 
software (Viewer settings bit depth is byte) Viewer mode has always done.

• Viewer buffer depth and whether to use GPU processing are now separate settings: gl 
buffer depth and a new check box called use GPU for viewer. Previously, the options 
were byte (CPU processing), half-float (GPU), and float (GPU), but now CPU processing 
can additionally be used in half-float and float modes. Note, however, that GPU 
processing is only used when it is both selected in the Viewer settings and supported 
in hardware. Otherwise, CPU processing will be used. The default setting is byte mode 
with use GPU for viewer and use GPU for inputs disabled. 

• Added an apply LUT to color channels only option in the Viewer settings to choose 
whether the LUT is applied to non-colour channels. By default, it is.

On the Viewers tab of the Preferences, you can also check apply LUT to color channels 
only to only apply the LUT to the red, green, and blue channels. Note that this only 
affects Viewers created after the preference was set. 

If you want your change to also apply to existing Viewers, you can relaunch Nuke and 
reload your script. Alternatively, you can change this for individual Viewers in the 
Viewer settings.

• Proxy Mode
When the proxy mode is on, it now allows the images read from disk to be scaled up as well 
as down. This gives you two new abilities:

1. The proxy image can be used even if the proxy scaling is larger than the size the proxy 
image was made for.

2. You can use the proxy mode to scale up your composite to any size, enlarging the full-
size or proxy images to your desired size.
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A new read proxy files menu has been added to the Project settings panel. This controls 
when the proxy file is used rather than the normal file:

• never - Never use the proxy file in the proxy mode. Instead, scale the full-size file as 
necessary.

• if larger - Use the proxy file if it is equal to or larger than the resolution required for 
rendering, otherwise use the normal file. The one selected will be scaled down to the 
proxy rendering resolution as needed. This is the default option and matches the 
functionality in previous versions of Nuke. 

• if nearest - Use the image that is closest to the required size, scaling up or down as 
necessary.

• always - Always use the proxy image, scaling it up or down as necessary.

Note that these options only apply when proxy mode is active. If proxy mode is not ena-
bled, then the normal file will always be used.

For more information, see Proxy Mode on page 98 of the User Guide (and pages 100-102 
in particular).

• Read and Write Properties

• As before, Nuke by default assumes an exact relation between the current frame 
processed, and the frame read in or written out. For example, at frame 15, Nuke reads 
in or writes out image.0015.rgb. However, you can change this behaviour using the 
frame parameter, which is now available on both Read and Write nodes and also now 
features a pulldown menu to select different interpretations of the value you supply. 
For instance, if you have a sequence that runs from image.0500.rgb to 
image.1000.rgb, you may want to read in image.0500.rgb at frame 1, or render the 
sequence so that the frame numbering in the resulting files runs from image.0001.rgb 
to image.0501.rgb. Nuke lets you do this via expressions, specified start frames, and 
constant offsets.

For Read nodes, the default menu item expression is correct for backwards compatibil-
ity.

For more information, see Changing the Relation Between the Current Frame and the 
Frame Read in on page 110 of the User Guide and Changing the Numbering of Ren-
dered Frames on page 388.

• In the Write node controls, there is a new read file toggle. This toggle, when on, lets 
you use the Write node to read the rendered image back in. Because reading the output 
of a Write node from a file is faster than calculating its output by processing the node 
tree upstream, this can be particularly useful on large comps. When you have finished 
working on a branch of the node tree, you can insert a Write node after it, render the 
output, and use the same Write node to read the rendered image in. If you later need to 
edit the nodes upstream, simply make your changes and render the Write node again to 
update the image being read in.

For more information, see Using a Write Node to Read in the Rendered Image on page 
390 of the User Guide.

• The colorspace knob in Read/Write nodes has a default item, but there was no 
indication to the user as to what that default is. For example, for .cin files it is Cineon, 
for JPEG files it's sRGB. The item now states what the default actually is.
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• Grouping and Ungrouping Nodes

• You can now create a Group node in two ways:

Select Edit > Node > Group > Collapse to Group (or press Ctrl/Cmd+G) to replace 
the selected nodes with the Group node. This option did not exist in earlier versions of 
Nuke.

Select Edit > Node > Group > Copy Nodes to Group (or press Ctrl/Cmd+Alt+Shift+G) 
to keep the selected nodes in the layout in addition to the Group node. This is how 
grouping nodes worked in earlier versions of Nuke. Note, however, that the menu item 
and the hot key have changed.

There is also an option to ungroup nodes by replacing the Group node with the nodes 
nested inside it. This option is called Expand Group and can be found in the Edit > 
Node > Group menu, where the options related to grouping nodes have been moved. 
The hot key for this option is Ctrl/Cmd+Alt+G.

For more information, see Grouping Nodes with the Group Node on page 116 of the 
User Guide.

• The behaviour of the Output node within a group or gizmo has changed. Before, the 
output node did not have to be connected to show in the Viewer. However, in 5.2 you 
need to attach the Output node to the Viewer.

• Text Node
The Text node now supports automatic word wrap. 

The node also shows an on-screen box that limits the text inside a certain area of the 
frame. To reposition this area, drag the centre of the box to a new location. To resize the 
area, drag the corners or edges of the on-screen box to a new location.

In the Text node controls, the horizontal justify menu also has a new justify option. This 
option lets you align the text both along the left and the right edge of the on-screen text 
box, leaving no ragged edges. 

For more information, see Creating Text Overlays on page 289 of the User Guide.

• GenerateLUT and Vectorfield (3D) Nodes
Improved support for loading and generating 3D LUTs. 

The Vectorfield and GenerateLUT nodes can now load and create LUTs in the following for-
mats: 

LUT format Load (using Vectorfield) Create (using GenerateLUT)

.3dl - Autodesk/Scratch format  

.blut - Houdini binary LUT format  

.cms - CMS file format 1 

.csp - CineSpace format  

.cub(e) Truelight 1D or 3D LUT  

.cube - Iridas LUT format  

.vf - Nuke Vectorfield format  

.vfz - gzip compressed .vf files  
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Both the GenerateLUT and Vectorfield nodes now include a file type menu which lets you 
specify the LUT format if you want to override Nuke's guess based on the file extension.

The Vectorfield node also includes the following new controls:

• colorspace in - determines how to convert from Nuke’s linear colourspace to the input 
required by the 3D LUT.

• colorspace out - determines how to convert from the 3D LUT's output to Nuke’s linear 
colourspace.

• GPU extrapolate - controls whether the graphics processing unit (GPU) 
implementation extrapolates the grid values or clamps to the maximum value of the 
LUT. In most cases, this parameter should be on.

• Environment Variables
There are two new environment variables:

• NUKE_DEBUG_MEMORY has been restored. 

When working on large images, Nuke may need to free up memory during rendering. 
When this happens, Nuke prints the following information to the console:

Memory: over maximum usage, trying to reduce usage from 1GB to 924MB.

When this environment variable is set to 1, the above message is followed by more 
detailed debug memory messages, which can be useful for trouble-shooting.

If this variable is not set, you cannot see the more detailed debug memory messages.

• NUKE_EXR_TEMP_DIR

This is the location Nuke will use for temporary files while reading PIZ-compressed EXR 
files on Linux. This environment variable is only relevant on Linux. 

If this is not set, the NUKE_TEMP_DIR location is used.

For more information on Nuke environment variables, see Environment Variables on page 
457 of the User Guide.

• File Formats

• As before, QuickTime is only supported by default on 32-bit Windows and Mac OS X. 
However, to use QuickTime files on Linux, you can now use the prefix ffmpeg: before 
the file path and file name, for example:

ffmpeg:\z:\job\FILM\IMG\final_comp_v01.####.mov

When working with Write nodes, you can also choose ffmpeg from the file type menu 
and use .mov as the file extension. This way, Nuke will use its reader/writer that is 
based on the FFmpeg open source library to decode/encode QuickTime files.

FFmpeg is available on all platforms except Windows 64-bit.

Note that we are using this open source library to encode the output images, so image 
data may be subject to colourspace and transform shifts dependant on the codec 
employed.

The binary plug-in was compiled with r15261 and is compatible with libavcodec version 
51. Its dependencies are composed entirely of shared libraries and can use any com-

1. If the Vectorfield node does not recognise a .cms file, you can force it to load the file by changing the 
extension to .cub. 
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patible user compiled libavcodec by replacing the appropriate shared objects in the 
Nuke distribution folder.

The source code is also included in the NDK and can be custom compiled and the bun-
dled plug-in replaced.

• AVI files can now be supported by default or via Nuke’s reader/writer that is based on 
the FFmpeg open source library. If you get an error when using AVI files in Read nodes, 
you may need to use the prefix ffmpeg: before the file path and file name, for example: 
ffmpeg:\z:\job\FILM\IMG\final_comp_v01.####.avi

When working with Write nodes, you can also choose ffmpeg from the file type menu 
and use .avi as the file extension.

FFmpeg is available on all platforms except Windows 64-bit.

Note that we are using this open source library to encode the output images, so image 
data may be subject to colourspace and transform shifts dependant on the codec 
employed.

The binary plug-in was compiled with r15261 and is compatible with libavcodec version 
51. Its dependencies are composed entirely of shared libraries and can use any com-
patible user compiled libavcodec by replacing the appropriate shared objects in the 
Nuke distribution folder.

The source code is also included in the NDK and can be custom compiled and the bun-
dled plug-in replaced.

• On Windows, in order to support more codecs, the AVI reader now uses the DirectShow 
multimedia architecture. When decoding AVI files, DirectShow tries to find the 
appropriate codec on the system. If the codec is not available, DirectShow and Nuke 
are unable to open the AVI file. Note that the 64-bit version of Nuke can only use 64-
bit DirectShow codecs. If you only have a 32-bit codec installed, the 64-bit version of 
Nuke cannot use it to open AVI files.

• On Linux, the Nuke EXR reader uses a memory-mapping function to improve 
performance reading PIZ-compressed EXR files. However, some customers have 
experienced hanging when reading large (frame size and number of channels) PIZ-
compressed EXR files across an NFS network. If you experience this problem, you can 
tell Nuke not to use the mmap function by activating the disable_mmap option on the 
Read node. You can set it on a case by case basis or use a knobDefault in your init.py 
to always have it disabled (see Setting Default Values for Controls on page 424 of the 
User Guide).

For more information on file formats, see Supported File Formats on page 616 of the User 
Guide.

• File Browser
The File Browser now remembers its size, whether the preview tab is open, and the last 
directory you were in between runs of Nuke.

• Paint Node
The Paint node now flips into Eraser mode when the erase head of a wacom pen is used. 
However, when this happens, the Eraser tool button doesn't change state. This is

intended so you know what mode it's going to flip back into.
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• Tracker Node
You can now change the position of the progress bar window. The position is persistent so 
that if you close and relaunch Nuke, the progress bar window remains in the same position.

• Creating Nodes
Cmd/Ctrl + create node (using the Toolbar, Tab key menu, right-click menu, etc.) replaces 
the currently selected node in the node tree.

Shift + create node (create in branch) now places the new node beside the selected one 
instead of on top of it.

• Selecting a Node Tree
You can now select all nodes in a particular node tree. To do so, select the node and Edit > 
Node > Select Connected Nodes. You can also use the shortcut key Ctrl/Cmd+Alt+A to 
select all nodes in a tree. 

• Control Panels
Alt+click while pressing the close button in a control panel closes all panels in the Proper-
ties Bin. Cmd/Ctrl+click closes all except the one whose button is pressed.

• Undo and redo
Control Panel undo and redo buttons now get disabled when there is nothing to undo or 
redo.

• Search and Replace
Edit > Node > Filename > Search and Replace now works on all nodes with file and proxy 
controls as opposed to just Read and Write nodes.

• ColorLookup Node
There are five new controls on the ColorLookup node:

• source lets you pick a source colour for adding points.

• target lets you pick a destination colour for adding points.

• Set RGB lets you add points on the red, green, and blue curves, mapping source to 
target.

• Set RGBA lets you add points on the red, green, blue, and alpha curves, mapping source 
to target.

• Set A lets you add points on the alpha curve, mapping source to target.

You can use these controls to match shadow, midtone, and highlights on two plates, for 
example. Set source to shadow rgb in one, target to shadow rgb in the other, then press 
Set RGB. Same for midtone and highlight areas.  

The new controls can also be used to tint an image by making some picks for source, copy-
ing those values to target, using the colour picker controls to adjust them, and then hitting 
Set RGB.

• Expressions

• Added the following functions: toSRGB(x), toCineon(x), toRec709(x), and from versions.

These all translate the range 0-1 to 0-1. The old functions (to_sRGB, etc.) translated 

0-1 to the 0-255 range and are deprecated.

• Added the following C99 functions and constants:

isfinite(x) - x is not NaN or infinity.

isnormal(x) - x is finite and also big enough to be normalised. 
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For the curve expressions, this is false for 1e-320. For the colour expressions, which 
are done in float, this is false for 1e-38.

isnan(x) - x is NaN.

isinf(x) - x is infinity (note that NaN returns false).

signbit(x) - Return 1 if x is negative (including -0 and -NaN), or 0 otherwise.

copysign(x,y) - Return -abs(x) if signbit(y), otherwise return abs(x).

• Preferences
Some settings on the Preferences dialog have been slightly renamed or moved to another 
tab to increase clarity. Any preference settings for changing the behaviour of control pan-
els have been grouped together on a new Control Panels tab. On the Preferences tab, 
the disk cache size default value has also been increased from 5GB to 10GB.

For more information on the available preference settings, see Setting Interface Prefer-
ences on page 402 of the User Guide.

• Stereo Correlate Controls
On several controls, you get an option to correlate (current view) from (other view). How-
ever, often when working on one view, you expect to be able to push the correlation onto 
the other view and only then switch over and look at it.  All the correlates are now available 
no matter which view you are looking at.

• Crystal Eyes Output Mode
The Crystal Eyes output mode has been renamed to OpenGL stereo for quad-buffer stereo 
viewing.

• Error Messages
Nodes that exist in the Node Graph but are not needed to produce the output image no 
longer give out error messages. For example, having a node not connected to a node tree 
or having it skipped by a switch statement prevent error messages from appearing. This 
allows you to leave experimental gizmos in the Node Graph but still have the script work on 
a render farm.

• Script Editor
Tab and Shift+Tab now indent and unindent selected text like Ctrl/Cmd+Shift+[ and ].

• Python

• From now on, when you create a node using nuke.nodes.Class(), the new node will not 
automatically be connected to the selected node. This was done to allow users to 
create nodes without connecting them.

If you want the node to be connected, you can use the setInput() function, for instance: 
nuke.nodes.Class().setInput(0, nuke.selectedNode())

This will also work in older versions of Nuke.

Using nuke.createNode("Class") also automatically connects the new node to the 
selected one.

• The syntax nuke.Blur() to create a Blur node was deprecated in a previous release in 
favor of nuke.nodes.Blur(), though it remained functional for backwards compatibility. 
The deprecated syntax is now not supported at all due to conflicts it causes with other 
object names in the nuke Python module. Any lingering uses of it should be changed to 
the new syntax.

• You can now set frame ranges using Python. 
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For more information, see Setting Frame Ranges Using Python on page 427 of the User 
Guide.

• You can now copy animation curves from Python. For example:

b1 = nuke.nodes.Blur()

b2 = nuke.nodes.Blur()

k1 = b1['size']

k1.setAnimated()

k1.setValue(10, time = 10)

k1.setValue(20, time = 20)

k2 = b2['size']

k2.copyAnimations(k1.animations())

or

k2.fromScript(k1.toScript())

• Menu items can now use Python callables instead of strings. Here are some Python 
examples of using both strings and callables:

def menuString():

    nuke.message( "String menu item" )

def menuFunction():

    nuke.message( "Function menu item" )

class myClass:

    def menuMethod( self ):

        nuke.message( "Class method menu item" )

mc = myClass()

m = nuke.menu( "Nuke" )

m.addCommand( "Test/String", "menuString()" )

m.addCommand( "Test/Function", menuFunction )

m.addCommand( "Test/Lambda", lambda: nuke.message( "Lambda function menu item") )

m.addCommand( "Test/Method", mc.menuMethod )

• A Python call has been added to get and set the active Viewer inputs. For example:

v = nuke.activeViewer()                       # existing object
v.activateInput(0)
v.activateInput(1)
v.activateInput(2, secondary=True)
print v.activeInput()
print v.activeInput(secondary=True)

• The 'argv' list of command line arguments has been exposed as a tuple called nuke.argv. 
For example:

Nuke5.2v1 /tmp/test.nk argv1 argv2 argv3

Script editor: 

import sys

print sys.argv
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# Result: ['/tmp/test.nk', 'argv1', 'argv2', 'argv3']

• The function nuke.tprint now behaves like the Py3k print function. For example:

FILE = open('K:/Temp/t.txt',"w")

nuke.tprint('hello', 'there', sep='*', end='-', file=FILE)

nuke.tprint('hello', 'there', sep='*', end='-', file=FILE)

FILE.close()

• A metadata() method has been added to the Node class to retrieve metadata in the 
stream at a particular node.

To get a Python dictionary with all the metadata for a node (in this case, Read1), you 
can use:

nuke.toNode("Read1").metadata()

If you’re interested in the metadata at a particular frame or in a particular view, you 
can also specify these as optional arguments:

nuke.toNode("Read1").metadata([frame[, view]])

To get the value for a particular key in the metadata, use:

nuke.toNode("Read1").metadata("key")

For example, nuke.toNode("Read1").metadata("input/ctime") will return the value for the 
key called input/ctime.

For more information, see Accessing Node Metadata on page 431 of the User Guide.

• Added Pickle support.

• Added node methods setSelected() and isSelected(). 

Node.setSelected(s) selects the node if s is True (or non-zero), and deselects it if s is 
False (or zero). 

Node.isSelected() returns True or False depending on whether the node is currently 
selected. 

These are the same as using the 'selected' knob - for example, 

node['selected'].setValue(True).

• Added nukescripts.clear_selection_recursive() example to nukescripts/misc.py. 

Nukescripts.clear_selection_recursive(g) clears the selection for group g (or the root 
node if none is specified) and any group nodes it contains. After running this on the 
root node, you can be sure that no node in any group is selected any more.

• Added help() method to node class.

• Added width/height and bounding box to Node bindings. You can now get the bounding 
box and width/height from a node.

For example:

n = nuke.toNode( 'CheckerBoard1' )

print 'Width ' + str(n.width())

print 'Height ' + str(n.height())

bbox = n.bbox()

print 'Bbox' + str(bbox.x()) + ' ' +str( bbox.y() ) + ' ' + str( bbox.w() )+ ' ' + str(bbox.h() )
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• Added expression variables such as first_frame, last_frame to node class. The following 
new methods that were previously only available from expressions have been added to 
the node class:

node.firstFrame() 

node.lastFrame() 

node.error() 

node.frameRange()

• The nuke.makeGroup() command now returns the group and does not switch the 
context. For example, you can do:

gn = nuke.makeGroup()

tn = nuke.toNode("CheckerBoard1")

gn.setInput(0, tn)

Or, to switch contexts so thisGroup returns the group, do:

gn = nuke.makeGroup()

gn.begin()

## .. add nodes to group here

nuke.thisGroup() ## this is valid now as the context has changed to the group

gn.end()

tn = nuke.toNode("CheckerBoard1")

gn.setInput(0, tn)

Or, do this using the 'with' syntax:

from __future__ import with_statement

gn = None

with nuke.makeGroup():

  gn = nuke.thisGroup()

tn = nuke.toNode("CheckerBoard1")

gn.setInput(0, tn)

If you need the script to work both in 5.2 and earlier versions, you need to check the 
version number and switch behaviours based on it:

def makeGroup():

  group = None

  if nuke.env['NukeVersionMajor'] == 5 and nuke.env['NukeVersionMinor'] < 2:

    nuke.makeGroup()

    group = nuke.thisGroup()

    nuke.endGroup()

  else:
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    group = nuke.makeGroup()

  return group

gn = makeGroup()

tn = nuke.toNode("CheckerBoard1")

gn.setInput(0, tn)

• scriptSaveAs
The scriptSaveAs function has been rewritten so that TCL and Python can use without the 
GUI. Python nuke.scriptSaveAs now has various overwriting options to specify. TCL 
script_save_as now always overwrites.

• NDK Examples
The following new examples have been added to the NDK in response to customer ques-
tions about accessing certain Nuke capabilities:

• fnLogGeo as example of a geometry modifier plug-in

• an Axis example

• a Phong shader example

• a UVProject example.

• Test/src/Handle.cpp example node. This shows how to get mouse clicks in a plug-in.

Bug Fixes

• BUG ID 1540 - Multiple instantiations of a single plug-in created a problem with multiple 
progress bars.

• BUG ID 2072 - Error pop-up message stopped Viewer update.

• BUG ID 2132 - OnCreate.tcl - concatenate rather than override.
OnCreate.tcl has been deprecated, but you can concatenate with the new onCreate Python 
callback.

• BUG ID 2371 - Write: Render > Render All progress indication only appeared for the first 
file written.

• BUG ID 3123 - Nuke crashed if a region of interest (ROI) was used and monitor disabled in 
the Truelight controls.

• BUG ID 3185 - Color > Math > Expression: recognize NaN (not a number) as a pixel value.
An expression such as r=isnan()?0:r in an Expression node will fix all NaN pixels to zero.

• BUG ID 3428 - Slow rendering on a simple customer script.

• BUG ID 3617 - Merge: Video colorspace toggle tooltip should address premults on inputs - 
not just readers.

• BUG ID 3647 - Properties panels: the right-click menu’s Revert knobs and Set knobs to 
default did not work if there was a letter in the numerical value field.

• BUG ID 3708 - Leaving a createnode in your menu.py does not crash anymore.
A custom configuration of nodes at start-up can be used by saving a script as 'template.nk' 
and add it to the NUKE_PATH.
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• BUG ID 3857 - Decorating Node Graph nodes or control panel buttons or labels with 
images or icons wasn’t possible anymore.

• BUG ID 3893 - Winding up floating parameter panels should resize the panel itself to 
match the height once resized.

• BUG ID 3986 - Added italic font for the new, edit and delete commands in the output for-
mat control of the Reformat node.

• BUG ID 4010 - The CMSTestPattern node caused Nuke to crash if you set RGB 3D LUT cube 
size to a negative value or 0.

• BUG ID 4215 - Mac OS X: close button did not work on File Browser. 

• BUG ID 4234 - Constant message QFont::setPixelSize: Pixel size <= 0 (0) with a customer 
script.

• BUG ID 4358 - When opened, the File Browser defaulted to the nuke directory, rather than 
to the root directory. 
This was fixed as part of feature request 5279. Please see also bug 4631.

• BUG ID 4439 - Script Editor trapped focus when expanded with space bar and typed in. 
This meant you weren’t able to press space bar to expand and contract the Script Editor 
after you'd typed into it.  You can now do this as long as the mouse is not over the input 
text field.

• BUG ID 4477 - User guide: clarified the node connection tips in the Compositing Basics 
tutorial.

• BUG ID 4631 - The File Browser did not remember the last selected folder.
This was fixed as part of feature request 5279. The File Browser now remembers which 
directory you were last in within one session and between runs of Nuke.

• BUG ID 4799 - Truelight profile header default caused error messages to appear. 

• BUG ID 4805 - Trying to cancel a node rename in the control panel with the Esc button hid 
the panel.

• BUG ID 4969 - Control panel undo button ignored multiple channel changes.

• BUG ID 4992 - The Alt + I information box was not showing the channel information but 
only the channel sets.

• BUG ID 5087 - Write progress bar frequently didn’t update unless you clicked on the 
progress bar window.

• BUG ID 5114 - VectorField node was too sensitive to blank lines in 3dl files (from Flame).

• BUG ID 5181 - Vectorfield node: 3dl LUT from Digital Praxis was broken and came out four 
times what it should have been.

• BUG ID 5248 - Hitting Esc on a Bezier set a keyframe.

• BUG ID 5264 - Error dialogs were raised by commands even when run from terminal. 
For example, running the following code from the terminal used to produce the error 
QWidget: Cannot create a QWidget when no GUI is being used: 

b1 = nuke.createNode("Blur")
b2 = nuke.createNode("Blur")
print b1.knob('name').value()
print b2.knob('name').value()
b2.knob('name').setValue('Blur1') 
This now correctly prints node Blur1 already exists to the terminal.

• BUG ID 5292 - Submenu options on the right-click menu didn't always refresh if changed.
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• BUG ID 5342 - Label did not work for Link Knobs.

• BUG ID 5422 - Python: 'filename' command failed to return proxy unless it was the only file 
specified in the node.

• BUG ID 5482 Correlate/Ocula progress bars did not show any information about what they 
are processing.

• BUG ID 5547 - Write and QuickTime: not updating the progress bar.

• BUG ID 5592 - Rename node did not convert spaces to underscores.

• BUG ID 5595 - The right-click menu’s Set knobs to default on the project settings LUT tab 
caused blank drop downs, Selected Viewer LUT does not exist error messages, and various 
reported crashes and hangs.

• BUG ID 5626 - Reformat node: to box type did not proxy scale.

• BUG ID 5645 - NDK examples makefile was missing frameworks, manifests, and miscellane-
ous other flags.

• BUG ID 5662 - Read nodes with only a proxy file name did not work in proxy mode.

• BUG ID 5682 - Local undo of file name change did not work.

• BUG ID 5783 - New nodes were not inserted correctly into multiple connections.

• BUG ID 5802 - Reformat control panel disabled unrequired knobs rather than hid them.

• BUG ID 5807 - Curve Editor error message about hot keys didn’t mention Cmd instead of 
Ctrl on Mac OS X.

• BUG ID 5858 - Node controls: interactive expression updating was not working if the result 
of the expression matched the currently entered value.

• BUG ID 5859 - Shuffle controls were not accessible if you selected Manage User Knobs 
from a group or gizmo.

• BUG ID 5884 - There was no way to remove animation on certain checkboxes (for example, 
hide input and postage stamp).
The right-click menus of these checkboxes now have the No animation option for removing 
animation.

• BUG ID 5898 - On Mac OS X, text on nodes on the Node Graph is fuzzy, hard to read, and 
loses lines occasionally. 
The default font has been changed to Helvetica on Mac OS X. This should fix the problem of 
text losing lines.

• BUG ID 5899 - Write: QuickTime alpha channel was getting written out slightly down and 
to the right of where it was created.

• BUG ID 5902 - Stereo: expression set in unfurled knob that is not the current displayed 
view went to current view knob.

• BUG ID 5906 - Edit > Remove Input should disconnect all inputs to the current node. 

• BUG ID 5930 - NO_ANIMATION knobs did not disable expression input.

• BUG ID 6075 - Ocula related: correlating with Ocula was slow compared to correlating with 
disparity.

• BUG ID 6097 - Script with Paint, OFlow, and TimeOffset nodes crashed when dragging the 
timeline slider.

• BUG ID 6098 - Selecting Set knobs to default from the right-click menu set the node back 
to its original state but left behind an animation curve in the Curve Editor.
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• BUG ID 6110 - Python: docstrings for nuke.getClipname and nuke.getFilename didn’t 
describe arguments.

• BUG ID 6141 - VectorBlur crashed Nuke when certain uv channel types were selected.

• BUG ID 6155 - OFX: in some circustances, the progress bar for an OFX plug-in would not 
close after the plug-in had finished processing.

• BUG ID 6164 - Qt 4.4: QObject: Do not delete object, 'ColorCorrect50', during its event 
handler errors.

• BUG ID 6170 - Various knobs names needed to have a space removed to be legal identifi-
ers from Python.

• BUG ID 6194 - Cutting and pasting Read nodes from text caused them to link together.

• BUG ID 6217 - Preferences: memory usage slider should not be animatable.

• BUG ID 6226 - Bezier autokey created a key at frame 0.

• BUG ID 6249 - Support some of the old Nuke 4.x style icons and text formatting in labels.
The following Nuke 4.x style text labels are supported: 

This is @b bold 

@n This is normal 

This is @i italic @n 

This is @b @i bold italic 

@n This is an icon @myIcon.png 

• BUG ID 6295 - Python: nuke.knobDefaults did not work on OFX nodes.

• BUG ID 6303 - Moved Merge2 node channels back to the main tab.

• BUG ID 6310 - On Ubuntu GNOME, Alt+S didn’t get windows out of the full-screen mode 
when they had been saved in the default layout.

• BUG ID 6331 - Script with Ocula’s O_DisparityGenerator plug-in crashed Nuke when view-
ing the disparity map.

• BUG ID 6355 - Python: File_Knob and Link_Knob did not return the same values.

• BUG ID 6359 - Merge: simultaneous render of L and R views produced only L on first frame 
from the R Write node.

• BUG ID 6415 - ReConverge node: on Windows, the Use Ocula if available option caused a 
crash when reloading a script.

• BUG ID 6423 - Set knobs to default did not work for LookupCurveKnob.

• BUG ID 6430 - Nuke crashed or did not play back from the cache with a customer script.

• BUG ID 6510 - Avid DNxHD encoded QuickTime crashed Nuke on import.

• BUG ID 6556 - Bezier data was not imported correctly from a custom exporter.

• BUG ID 6568 - Python: no error message for bad knob names. Mistyping a knob name did 
not produce any error, making it difficult to figure out why your script was not working. For 
example: nuke.createNode('Read', 'nosuchknob blah').

• BUG ID 6572 - Stereo: Switching between left and right views did not update the 3D 
Viewer on a particular customer script.

• BUG ID 6575 - Problem evaluating file names with expressions. 
Putting an expression such as [python nuke.toNode('Text1')\\\['message'\\].value()] on a file 
knob used to always result in an error similar to Can't load writer for file type "file".

• BUG ID 6584 - Command line render times were slow on a customer script.
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• BUG ID 6596 - Show an error when executing a Write node with a disconnected input. 
Earlier versions of Nuke did not error out when you did a render specifying the node name 
and that node did not have an input. 

For example: nuke -x myscript.nk -X SomeWriteNode1

• BUG ID 6600 - Reconcile3D node calculated keyframes at half the values they should be in 
proxy mode.

• BUG ID 6605 - PointsTo3D node calculated keyframes at smaller values in proxy mode.

• BUG ID 6615 - Crash when running track to last frame on certain machines. 
This was actually fixed in Nuke 5.1v4 but not documented in the release notes. The fix was 
part of Bug 7196, which was the result of machines crashing without SSE3.

• BUG ID 6619 - OFX: problems with region of interest (ROI) handling.

• BUG ID 6623 - EXR reader errored with Cannot find frame buffer slice "R".

• BUG ID 6626 - LayerContactSheet node mismatched motion channels.

• BUG ID 6629 - Opening a particular script caused the Viewer not to process full frame or 
hang after processing a small part of it.

• BUG ID 6671 - Transform knobs on 3D sources not concatenating/drawing at correct posi-
tion. The 3D trajectory/motion path displayed in the OpenGL Viewer did not line up with 
cameras and also moved with the object.

• BUG ID 6680 - Chain of expressions caused the wrong 3D Viewer redraw.

• BUG ID 6686 - Script Editor: Tabs pasted from external text were not converted to spaces.
Tabs are now converted to spaces when pasting into Nuke.

• BUG ID 6689 - Reinstated the 3D > Shader > BlendMat node.

• BUG ID 6693 - The Sampler node didn't redraw.

• BUG ID 6696 - Made {, }, [, and ] toggle the visibility of top/bottom/left/right Viewer tool-
bars respectively.

• BUG ID 6698 - Crash with the LevelSet node.

• BUG ID 6707 - Write .EXR render output showed a one-pixel border.

• BUG ID 6724 - Python: setHeight set width, and setWidth set height.

• BUG ID 6738 - SourceGeo nodes’ (Card, Sphere, Cube, Cylinder, ReadGeo, etc.) 2D knobs 
displayed incorrectly when locally transformed.

• BUG ID 6739 - Crash on exit after using an OFX plug-in in some circustances.

• BUG ID 6751 - The right-click menu for Paint points in the Viewer had open\/close curve 
instead of open/close curve.

• BUG ID 6752 - Python: knob().value() used the value from the previous frame when scrub-
bing.

• BUG ID 6762 - Python: crash when command line rendering with menu-related code in 
init.py. 
Menu-related code should not be used in init.py without checking nuke.env['gui'] as Nuke 
may be running in render or terminal mode. Using menu-related code used to crash Nuke.  
It now throws an exception: RuntimeError: not in GUI mode.

• BUG ID 6767 - FBX files from Maya with units of feet did not read correctly. 

• BUG ID 6779 - Deleting an OFX plug-in and then undoing the delete made the plug-in dys-
functional.
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• BUG ID 6786 - Stereo: correlate with Ocula and correlate using disparity gave incorrect 
results in proxy mode. 

• BUG ID 6788 - Viewer handles disappeared on OFX plug-ins when the xy position knob was 
split.

• BUG ID 6793 - Ocula’s O_VerticalAligner plug-in: activating the proxy mode and switching 
views squashed or stretched the image.

• BUG ID 6794 - The undo buttons in node controls should be disabled when there is nothing 
to undo.

• BUG ID 6802 - When using an OFX plug-in, if you quit Nuke during Viewer playback, Nuke 
would occasionally crash.

• BUG ID 6836 - Upper-case FBX file extensions were not detected as FBX files.

• BUG ID 6839 - A particular Ocula script crashed with a Bus error. 

• BUG ID 6840 - Recent files were not updating in the File menu when using the File > Save 
New Version and File > Save As functions.

• BUG ID 6851 - Read node: Viewing a particular dpx file and hitting S to open the project 
settings crashed Nuke.

• BUG ID 6852 - Python: scriptSaveAs() was not mentioned in the documentation.

• BUG ID 6859 - Initialization of sys.argv produced the following error: IndexError: list index 
out of range.

• BUG ID 6861 - Nuke produced a Segmentation fault error with a customer script when max 
nodes in Properties bin was set to 1 in the Preferences.

• BUG ID 6867 - User knob disabled via setFlag() didn't save that to script - the knob was 
enabled when the script was loaded.

• BUG ID 6875 - User guide: the limit that is applied to Viewer's image size was undocu-
mented. 
This is now documented on pages 69 and 108 of the User Guide.

• BUG ID 6886 - Single channel exr read failure - read exr luma ("y") into rgb rather than into 
disparityL.y.

• BUG ID 6887 - Python: correction to the help description for nuke.knobDefault.

• BUG ID 6892 - Front projection bug: ScanlineRender differed from Viewer when certain 
translation or rotation values were changed in the Axis or the render Camera.

• BUG ID 6894 - Creating items in submenus didn't work properly. 
For example, this now works correctly: 

m = nuke.menu('Nuke')
i = m.addMenu('File/Import', index=7)
i.addCommand('Import PTGui', "nuke.tcl('import_ptgui_v02')")

• BUG ID 6905 - On Windows, OFX plug-ins were not loading correctly if you deleted the 
OFX cache and had over 200 OFX plug-ins installed.

• BUG ID 6908 - Format names with spaces could not be used in the knobDefault command.

• BUG ID 6909 - Creating floating windows from Python and deleting the node caused Seg-
mentation fault errors. 
This applied to situations where you were using floating control panels (that is, you had set 
new panels go to to own window on the Control Panels tab of the Preferences) and you had 
a custom node with a button that runs a Python script that creates a panel with something 
like:
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p = nuke.Panel('Choose Render')
result = p.show()
If you subsequently deleted and recreated that node and pressed the button again, Nuke 
crashed with a Segmentation fault error.

• BUG ID 6912 - The label of a linked knob inside a Group was different in Nuke 5.1 than in 
Nuke 4.8v2.

• BUG ID 6930 - Python: the <node>.knobs() command returned a name/class pair, and not a 
name/value pair.
This was an error in the Python documentation and has now been fixed. The functionality 
has not changed.

• BUG ID 6949 - When used together with a Paint node, moving a control point in Bezier and 
hitting undo didn’t work properly.

• BUG ID 6951 - Tooltip showing an expression didn't update after clearing the animation 
with the No Animation option of the animation menu.

• BUG ID 6968 - The FrameCycler wrapper script didn't work if a separate FrameCycler was 
installed.

• BUG ID 6972 - Colour Picker didn’t update when animated. 

• BUG ID 6980 - A Defocus node after a Flare node caused bus error in a customer script.

• BUG ID 6990 - Viewer OpenGL quad buffer stereo display mode was broken under certain 
OS and driver combinations.

• BUG ID 6994 - A script with four F_Kronos plug-ins crashed Nuke when writing frames. 

• BUG ID 7002 - Projection/ScanlineRender: stretch distortions in the 2D Viewer.

• BUG ID 7004 - Tracker node’s box was appearing smaller and offset towards the bottom 
left corner of the Viewer with stereo footage.

• BUG ID 7006 - Viewer playback sometimes paused.

• BUG ID 7022 - With certain Linux window managers, the dialog you get when you select 
File > Script Command had a messed up layout.

• BUG ID 7043 - Nuke crashed after File > Clear in conjunction with node animation and the 
Curve Editor.

• BUG ID 7055 - TimeEcho node crashed a script with bus error.

• BUG ID 7062 - Tracker node related crash: exception thrown from event handler.

• BUG ID 7079 - OFX plug-in controls with no animation still allowed expression setting with 
=.

• BUG ID 7135 - User Guide didn’t include instructions for doing a 'silent' install.

• BUG ID 7146 - A test script crashed when trying to clear the script with File > Clear. Cre-
ating a Precomp node with an error (for example, an invalid file name) also caused a crash.

• BUG ID 7190 - Changed the "not set" appearance of nodes’ colour buttons to a single line.

• BUG ID 7194 - Shuffle node: selecting added channel on in 2 crashed Nuke.

• BUG ID 7221 - Python: sys.stdout and sys.stderr were not functional. This broke logging 
module. 
This code now works correctly: 

import logging
logging.basicConfig(level=logging.DEBUG)
logging.info('Nuke')
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• BUG ID 7229 - User guide: when describing the default LUT settings, 8-bit files should 
note that the Primatte and Truelight nodes also use this setting. 

• BUG ID 7258 - Setting monitor on the LUT tab of the Project settings to Cineon or a user 
LUT disabled z buffering in the 3D viewer. 

• BUG ID 7263 - Selecting Set knobs to default from the Tracker controls’ right-click menu 
started tracking.

• BUG ID 7266 - Bus error crash when disabling a cached Read node.

• BUG ID 7295 - Rare caching crash found through VectorBlur test.

• BUG ID 7296 - Nuke crashed when setting an expression on a file-format-specific knob in 
the Write node, and changing format.

• BUG ID 7298 - Python: sys.path - time to load modules took too long due to the appending 
of NUKE_PATH. 
This can happen if you add a lot of directories to the plug-in path, as the sys.path and 
plug-in path are kept in sync. You can now stop this behavior by passing addToSys-
Path=False when adding the path. For example:

nuke.pluginAddPath("/mnt/netpics/AllShotByName", addToSysPath=False)

• BUG ID 7317/7146 - A test script crashed when trying to clear the script with File > Clear. 
Creating a Precomp node with an error (for example, an invalid file name) also caused a 
crash. 

• BUG ID 7327 - Could not link or paste an expression to a split parameter.

• BUG ID 7330 - ColorMatrix node: Array knobs organized in a matrix didn't animate cor-
rectly and the curve correspondence was incorrect.

• BUG ID 7339 - Documentation: nuke.Node.fullName() was listed as nuke.Node.fullname().

• BUG ID 7347 - ReadGeo node: updated read from file tooltip regarding FBX files.

• BUG ID 7357 - Python: nuke.filename() did not return proxy file name for Read nodes.

• BUG ID 7360 - Changing the file type in a Write node still rendered with the old file type.

• BUG ID 7361 - Python: creating Read nodes from Python caused instability and crashes. 
Doing this no longer causes problems in Nuke: 
n = nuke.createNode("Read") 
n.knob("file").setValue("/tmp/color.%04d.exr") 
However, to set up the formats correctly, it is still recommended that you call fromUser-
Text rather than the above. For example:

n = nuke.createNode("Read") n.knob("file").fromUserText("/tmp/color.%04d.exr")

• BUG ID 7367 - Custom animation menu was not available for bool knobs.

• BUG ID 7373 - API: TextKnob did not keep its name.

• BUG ID 7374 - OFX buttons were getting saved with "" as the value when they didn’t have 
a value to save. 

• BUG ID 7375 - Python: error in filenameFix function masked traceback errors.

• BUG ID 7379 - Multiline string knob did not resize vertically. 

• BUG ID 7392 - Grouping clones sometimes caused some weird connections.

• BUG ID 7393 - User-defined filenameFix popped up a message box showing last filename 
passed to it on GUI Writes.

• BUG ID 7406 - Crash with a customer script triggered by changing the whitepoint of a 
Grade node.
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• BUG ID 7410 - Painting to a single frame was not working when the frame is a number in 
millions.

• BUG ID 7424 - Old, deleted views 'haunted' scripts and messed up renders.

• BUG ID 7431 - Change default format to 2k full ap via formats.tcl. 

• BUG ID 7444 - TCL: format named by just width and height did not work.

• BUG ID 7448 - Python: setName allowed dots and spaces in node names. 

• BUG ID 7460 - Entering a negative frame range into the File > Goto Frame dialog did not 
work.

• BUG ID 7471 - Array knob UI didn't update with calculated value when an expression over-
rode typed in value.

• BUG ID 7483 - Paste Knob Values ignored animation and expressions. 

• BUG ID 7497 - Using the Python sample function on a Text node that was followed by a 
Transform node with scale set to 0 produced a Segmentation fault error.

• BUG ID 7500 - Python: sample dx and dy parameters didn't work properly. 

• BUG ID 7510 - Vectorfield node caused Segmentation faults with particular LUTs and super 
white values.

• BUG ID 7513 - Python: scriptSave and scriptSaveAs doc strings were inaccurate.

• BUG ID 7555 - Python ‘with’ statement did not work for Group nodes.
For example, 

from __future__ import with_statement
with nuke.toNode('Group1') as myGroup:
    print myGroup

• BUG ID 7556 - Merge: bounding box was incorrectly displayed when set bbox to was set to 
A, and input B was coming from ScanlineRender and had a larger bounding box.

• BUG ID 7564 - Python: nuke.dependencies and dependentNodes didn’t work for nodes 
inside Groups.

• BUG ID 7573 - Adding Bitmask_Knob crashed Nuke. 

• BUG ID 7578 - Frame ranges: separating multiple frame ranges with spaces didn’t work.
A frame range such as 1-3 5 7 9 now expands to frames 1, 2, 3, 5, 7, and 9.

• BUG ID 7590 - Setting the Backdrop node’s bdwidth/bdheight knobs using Python or TCL 
did not work.

• BUG ID 7592 - ReadGeo didn’t load fbx file over UNC paths.

• BUG ID 7599 - Search and replace was only working for the current mode, so full-res file 
names weren’t replaced when in proxy mode.

• BUG ID 7602 - 3D Texture maps were getting corrupted in a script that had a 1-1 ranged 
Read node.

• BUG ID 7603 - With certain large scripts, all frames were cached but there was no playback 
in the Viewer.

• BUG ID 7607 - Merge: if the inputs A and B to multiply were both negative, the result dif-
fered from the tool tip description.
The tool tip has now been fixed. 

• BUG ID 7612 - Crash with a customer write proxy script.

• BUG ID 7622 - Initial opening of File Browser on root location came up empty.
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• BUG ID 7628 - The method for addressing individual views via expressions didn't work. 

• BUG ID 7640 - Viewer: selecting a channel from the rightmost channel menu caused an 
unnecessary recalculation.

• BUG ID 7645 - There was a tool tip typo in the window for adding a Command Menu user 
knob.

• BUG ID 7651 - Viewmetadata was not always showing current frame values.
The DPX edgecode knob is still incorrect. This is an old system that will be phased out. 
Please use the metadata edgecode value which is correct.

• BUG ID 7654 - Metadata: rendering failed with the following error: Write failed [invalid key 
code perforation offset (must be between 0 and 119)]. 

• BUG ID 7655 - STMap: a certain script crashed when zooming, panning, and changing 
frame.

• BUG ID 7673 - Flare help tooltip had some garbage text and a typo. 

• BUG ID 7674 - nuke.knobDefault('Viewer.gl_buffer_depth', 'byte') caused subsequent knob-
Defaults on the Viewer Process to fail/produce errors.

• BUG ID 7682 - Nuke crashed when a ShuffleCopy node was added to a script that had five 
channels in a channel set. 

• BUG ID 7690 - Playback was slow on a certain script after caching.

• BUG ID 7694 - Transforms should concatenate even with impulse filter.

• BUG ID 7700 - Cancelling renders: problems with Ctrl/Cmd+C, Ctrl+Break, and related 
behaviour in the console.
On all platforms, Ctrl/Cmd+C on the console cancels any current render and exits Nuke, 
whether in terminal or GUI mode.

On Windows, Ctrl+Break on the console cancels any current render if one is active. If none 
is active, in GUI mode nothing happens, and in terminal mode Nuke exits. Clicking on the 
close button in the console window cancels any current render and exits Nuke.

• BUG ID 7703 - Running a Python script with -x produced warnings about unused argu-
ments. 

• BUG ID 7704 - The tooltip delay preference wasn’t working.
The tooltip delay preference has been removed and replaced with a preference that lets you 
enable and disable tooltips (tooltips on).

• BUG ID 7708 - Gridwarp added a keyframe at frame -1234.57.

• BUG ID 7714 - FillMat layer control initialised to random values.

• BUG ID 7716 - Python: hasExpression() did not show up for all animatable knobs, only 
array knobs.

• BUG ID 7755 - Nuke crashed when viewing ColorWheel in motion channels.

• BUG ID 7756 - Inconsistent caching in a certain script with expression set. 

• BUG ID 7767 - The FillMat node didn't set the material to the right colour in the 3D view.

• BUG ID 7768 - The AnimationKey documentation was not included in the online Python 
Scripting documentation.

• BUG ID 7785 - Python: redefined __repr__.
Running something like

b = nuke.allNodes()
print b
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now returns both the node name and the memory information, for example:

# Result: [<Write1 at 0x13400e80>, <Viewer1 at 0x13400e90>, <CheckerBoard1 at
0x13400f40>]

• BUG ID 7793 - Add+Multiply+VectorBlur producing different results from a VectorBlur with 
offset and scale. 

• BUG ID 7820 - MergeMat, FillMat, and EdgeDetect: the layer control is now called channels 
for consistency.

• BUG ID 7826 - Python: evaluating a file knob in a gizmo produced the following error: no 
plugin named "file]Reader" found. 

• BUG ID 7827 - Start new line flag got lost on LUT knob when ColorLookup was grouped or 
copied and pasted.

• BUG ID 7849 - TCL: you can now save single curly braces in Nuke scripts without problems. 

• BUG ID 7851 - Added more comprehensive help documentation for nuke.dependencies().

• BUG ID 7862 - Read node: 10-bit rec709 dpx files defaulted to sRGB colorspace conver-
sion, not rec709.

• BUG ID 7863 - Python: format reference crashed Nuke. This crashed Nuke 5.1 if any 
unnamed format was present ( for example, created by a Read node with a non-default for-
mat ): for format in nuke.formats(): print format.name()

• BUG ID 7864 - User guide: added instructions for the Viewer’s frame range lock field and 
toggle.

• BUG ID 7871 - Format knob defaults were not working from formats.tcl. To fix this issue, 
format initialisation was moved from menu.py to init.py.

• BUG ID 7902 - Script Editor: unindent did nothing on indents of less than four spaces.

• BUG ID 7907 - Nuke crashed when reading YUV QuickTime movies with black_outside.

• BUG ID 7912 - User Guide: frame_range icon in screenshots needed updating.

• BUG ID 7915 - Python: running help on an animation key object caused a crash. 

• BUG ID 7919 - Docs: Python callback example was incorrect.
nuke.addOnCreate(nuke.tprint, ('A', 'B'), {sep=','})
Should have been

nuke.addOnCreate( nuke.tprint, ( 'a', 'b' ), { 'sep': ',' } )

• BUG ID 7926 - Script Editor indenting was not working correctly after empty lines.

• BUG ID 7932 - Nuke segmentation faults with Python command to evaluate a view in a 
Write node. This command now works correctly: 
nuke.toNode("Write1").knob("file").evaluate(view="right")

• BUG ID 7954 - A particular script loaded without certain nodes due to an old gizmo exist-
ing in the .nuke folder. 

• BUG ID 7977 - A relatively simple script crashed on playback when a VectorBlur node was 
used.

• BUG ID 7979 - Python: nuke.zoom had slightly wrong documentation.

• BUG ID 7989 - Python panels: STARTLINE and ENDLINE were undocumented. The following 
flags have been defined in the Nuke namespace:
nuke.DISABLED
nuke.NO_ANIMATION
nuke.STARTLINE
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nuke.ENDLINE
These match the C++ API ( DDImage knobs.h ), and can be used with knob.setFlag and 
knob.clearFlag. They can be or'ed together to set multiple flags. The following enum has 
also been added when using the Tab_Knob:

nuke.TABENDGROUP
nuke.TABKNOB
nuke.TABBEGINGROUP
nuke.TABBEGINCLOSEDGROUP
For example, to create a open group in a Python panel:

mypanel.addKnob ( nuke.Tab_Knob('beginGroup', 'my group', nuke.TABBEGINGROUP ) )
# create knobs inside group here 
mypanel.addKnob ( nuke.Tab_Knob('endGroup', '', nuke.TABENDGROUP ))

• BUG ID 8006 - Fixed alignment of widgets in the Viewer. The zoom button was taller than 
all the other widgets, and the mask drop-down always clipped the text 'rgba.alpha'.

• BUG ID 8039 - Python: Channel_Knob depth argument did not match C++ API.
The third parameter when creating a Channel_Knob is the depth or the amount of channels 
for the checkboxes. The default for this argument is zero, meaning the default number of 
checkboxes (4).

For example:

Channel_Knob( “mychannels”, “Channels”, 3 )
Produces a channel knob with just r, g and b to tick.

Channel_Knob( “mychannels”, “Channels” )
Creates the default number of channels.

Note that Channel knobs with a non-default depth will not have the all option present in 
the channels drop-down.

• BUG ID 8156 - FBX geometry with a CheckerBoard img input was flickering when pressing a 
key in 3D view.
If FBX geometry did not have UV data, this flickering would occur. It now constructs a 
default UV set if none exists in the FBX file.

• BUG ID 8188 - FillMat GL view transparency was affected by the alpha. 

• BUG ID 8221 - Nuke beach-balled or hung for a few seconds when it reached the Viewer 
cache limit. 

• BUG ID 8226 - All channels were not being updated when re-reading in an errored Read 
node from its correct file location.

• BUG ID 8238 - The @ icon syntax was not working correctly in an icon knob. It required an 
icon plus an extension, rather than just an icon.

• BUG ID 8266 - Poor performance with Nehalem Mac Pro, with hyperthreading enabled. 

• BUG ID 8267 - Read node was not holding a single frame in the Viewer when the start and 
end of a frame range were set to the same number. 

• BUG ID 8303 - A script crashed when RGB channels were missing from OFX nodes.

• BUG ID 8337 - OFX nodes resulted in a lag in the Node Graph and Viewer with a certain 
script.

• BUG ID 8339 - Downrez glitches when scrubbing in the Viewer. 

• BUG ID 8366 - Nuke now writes multiple bounding boxes when rendering multiple views. 

• BUG ID 8465 - Grouping nodes with mutiple connections wasn’t working correctly.
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• BUG ID 8469 - Script calls to open .nk files added files to the recent files list. 
Files are now only added to the recent files list when they are opened using the graphical 
user interface (GUI).

• BUG ID 8491 - Dissolve crashed when dragging the which slider. 

• BUG ID 8531 - Versioning up a Read node (Edit > Node > Filename > Version Up) printed 
the version number to the Script Editor.

• BUG ID 8548 - Attaching a Viewer node to a Tracker node crashed Nuke when using a spe-
cific script.

• BUG ID 8565 - The Viewer node occasionally displayed the wrong keyframe overlay for 
OFX nodes.

• BUG ID 8673 - Hashes intermittently changed in the 3D system, which caused DiskCache 
and Viewer cache recalculation.

Known Issues and Workarounds

• On 32-bit Windows XP, writing QuickTime files to UNC paths may not work if you are using 
an older version of QuickTime. This is due to a bug in QuickTime rather than Nuke. The 
solution is to use the latest version of QuickTime.

• QuickTime is not provided by Apple for Windows 64-bit applications and is not available in 
the Windows 64-bit version of Nuke at this time.

• On Mac OS X 10.5 (Leopard), when the Viewer is set to the OpenGL stereo stereo display 
mode, Nuke may trigger an OS X bug that causes a kernel failure. This is due to a bug in OS 
X 10.5 to do with stereo OpenGL support. For this reason, we do not recommend using the 
OpenGL stereo stereo viewing mode in Nuke on Leopard at this time. The bug has been reg-
istered with Apple as bug number 5897735.

• We direct FrameCycler to write to the user’s Nuke temp directory (NUKE_TEMP_DIR) for its 
user settings files. You can redirect this by modifying the FrameCycler/settings/
Global_Settings.xml file that can be found within your Nuke installation.

• If you have trouble with FBX files, it may be because they were written with an older ver-
sion of FBX. If they load very slowly, it is also possible that they are ASCII rather than 
binary. To get around these problems, you can use the FBX converter on the Autodesk web 
site. It converts between various different formats, including older FBX versions, ASCII, and 
binary, and is available on Windows, Mac OS X, and Linux.
To download the FBX converter:

1. Go to http://usa.autodesk.com/adsk/servlet/index?siteID=123112&id=10775855.

2. Scroll down to FBX Converter and click on one of the links to start the download.

• BUG ID 5063 - ScanlineRender: orthographic projection mode not working. This was fixed 
earlier, but the fix caused bug 5978 and so has been removed. The bug will be addressed 
more correctly in a subsequent release.

• BUG ID 5083 - Flipbooking the output of the Anaglyph node asks which view you want to 
render. This question is unnecessary as the result is an anaglyph image. Irrespective of 
what view you choose, the flipbook output will be the same.

• BUG ID 5690 - Windows run-time libraries were not packaged properly with Nuke.
Nuke will now run correctly from a network install on Windows without specifically install-
ing the run-time libraries, though we still recommend that you do so as there will still be 
some minor problems without them. For details, please see Installation on Windows in the 
Installation and Licensing chapter of the user guide.
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• BUG ID 5922 - At the moment, cloning does not work properly with all OFX nodes. This 
affects, but is not restricted to, any nodes that have an analysis pass.

• BUG ID 6455 - You should not call the Python command nuke.restoreWindowLayout() from 
the Script Editor as that can cause Nuke to crash. Instead, you can use the same command 
from your menu.py, restore layouts by selecting Layout > Restore Layout, or use a cus-
tom menu or toolbar item.

• BUG ID 6896 - On Linux, UI corruption may occur if you are running Nuke under window 
managers that support OpenGL-based effects (for example, Compiz or Beryl) and the 
effects are turned on (that is, System > Preferences > Appearance > Visual Effects 
has been set to either Normal or Extra). The solution is to set Visual Effects to None.

• BUG ID 7361 - Creating Read nodes with Python from Terminal caused instability. This was 
fixed in Nuke 5.1v4, but the fix caused bugs 7527 and 7535 and so has been removed.
The setValue call in a File_Knob does not set the frame range or formats, and therefore 
some instability may occur.

The fromUserText call does set the formats and frame range, but if no frame range is spec-
ified, it is reset to 1,1. Users are advised to save the previous frame range and set it after-
wards with n['first'].setValue and n['last'].setValue.

Example:

_n = nuke.nodes.Read()
_n['file'].setValue("/path/to/some/file")
should be

_n = nuke.nodes.Read()
_n['file'].fromUserText("/path/to/some/file")

If no frame range or formats need to be set, then the following is fine:

_n = nuke.nodes.Read()
_n['file'].setValue("/path/to/some/file")
Otherwise, you must set the format and frame range explicitly:

_n['first'].setValue(1)
_n['last'].setValue(100)

If you are doing fromUserText and want to maintain the original frame range, use:

_first = n['first'].value()
_last = n['last'].value()
_n['file'].fromUserText("/path/to/some/file")
_n['first'].setValue(first)
_n['last'].setValue(last)

• BUG ID 7964 - There is a Python syntax conflict when assigning knob names on the fly with 
nuke.nodes.<node>() if the knob is called 'in'.
For example, this will give a syntax error:

nuke.nodes.Shuffle( in = 'depth')

while this works because 'in' is a string here and not a keyword:

sh = nuke.nodes.Shuffle()

sh['in'].setValue('depth')

• BUG ID 8063 - Creating many new nodes with nuke.createNode() and the inpanel argument 
at default (True) may crash when too many node control panels are created too quickly. The 
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workaround is to pass the inpanel argument as False or else use nuke.nodes.NodeClass() 
(where NodeClass is the type of node to create) to create the node and then connect it to 
the currently selected node manually.

• BUG ID 8620 - On Windows, Tracker nodes can cause Nuke to crash with OMP abort: Ini-
tializing libguide.lib, but found libguide40.lib already initialized.
The workaround is to add the following system variable (not a user variable):

variable: KMP_DUPLICATE_LIB_OK

value: TRUE
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ere are the changes relevant to developers.

Changes for Nuke 5.2v1

Nodes in Nuke can have a GPU implementation. This is done by using a slightly modified GLSL 
syntax. A node can expose a GPU implementation from C++ by overriding Op's gpuEngine_decl 
and gpuEngine_body member functions.

The modified GLSL syntax adds the following as reserved keywords:

• IN - the texture map with original computed result from the CPU path.

• OUT - the cumulative result to be passed to the next node.

Knobs are referenced by enclosing their names in '$' symbols, for example:"$gain$".
Unique identifiers within the shader code can be obtained by prepending two dollar symbols 
"$$". For example: "$$lut".

Current limitations:

• Only nodes with one input are supported.

• The implementation will revert to CPU mode if there are nodes that require CPU mode 
between it and the Viewer.

• The GPU implementation is only available if the Viewer is in GPU mode (that is, gl buffer 
depth has not been set to byte in the Viewer settings).

• By default, GPU is only used for the Input Process and Viewer Process nodes. To use it for 
all nodes, check use GPU for inputs in the Viewer settings. Note that this can make the col-
our indicator at the bottom of the Viewer incorrect (as it shows the values from the last 
node processed in the CPU).

Currently, the ViewerLUT (1D LUT), Vectorfield (3D LUT), ViewerGain, ViewerGamma, Viewer-
LUT, ViewerDither, and ViewerChannelSelector nodes are shipped with a GPU implementation. 
There are also other two examples that you can use to develop your own nodes: GPUFileShader 
and GPUKuwahara. These are in the NDK with source code. GPUFileShader takes a file and 
applies the shader described in it. GPUKuwahara implements a multipass Kuwahara filter and is 
an example
of how such a filter can be implemented on the GPU within Nuke.

H
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DDImage API changes:

The class DD::Image::Exception has been removed. Functions that were previously throwing 
exceptions of this type now throw std::runtime_error objects instead. If you were deriving an 
exception class from DD::Image::Exception, please change it to derive from either std::excep-
tion or std::runtime_error.

"proxy" field added to OutputContext so you can detect the user turning on proxy mode even 
if the scale is 1:1.

"proxy" flag removed from some execute methods because it is no longer needed.

Iop::requested() has been renamed Iop::requestedBox().
Iop::requested() now returns true if request() has been called.

Iop::estimated_format() and Iop::estimated_full_size_format() have been removed. Use 
Iop::input_format() instead.

Memory - several functions have been renamed:
get_max_usage > max_usage
get_current_usage > current_usage
free_up_memory > set_current_usage

New metadata methods on Op:

To fetch metadata from an input, use
Op::fetchMetaData(const char *keyname)

This will fetch a MetaData Bundle including the metadata specified by keyname (or all meta-
data if keyname is NULL).

Example usage:
class MetaUser : public Op {

   void _validate(bool real) {
    // get the Bundle containing the filename:
    const MetaData::Bundle& meta = fetchMetaData(MetaData::FILENAME);
    // extract the filename from it:
    std::string filename = meta.getString(MetaData::FILENAME);
}

To provide metadata on your output, implement:
const MetaData::Bundle &_fetchMetaData(const char *keyname);

You can return a reference to a metadata bundle with /keyname/ in it, or all metadata that can 
be obtained if keyname is NULL.
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The default implementation of this method passes the metadata from input 0 along. The 
return value of _fetchMetaData() is cached by Op.

Example usage:
class MetaOp : public Op {

   MetaData::Bundle _meta;

   const MetaData::Bundle &_fetchMetaData(const char *keyname) {
      _meta = Iop::_fetchMetaData(keyname);
      _meta.setData("example/metadata", 15);
      return _meta;
   }

};

outputContext() will be valid in _fetchMetaData(), but knobs will not yet have been stored. If 
this is unsatisfactory, you can force a knob to be stored before a call to _fetchMetaData() by 
setting the Knob::EARLY_STORE flag on said knob.

For more information, see the NDK documentation.

Other changes for C++ plug-ins:

New kDDImageVersionInteger macro (set to 52001) allows simple #if statements for checking 
what version of Nuke you are compiling against.

Ability to declare knob groups that appear as toolbars at the edge of the viewer when the 
control panel for the node is open.

New FileReader object that stays in existence even when there is a different file for each 
frame. This allows file-type-specific knobs on the readers.

Note that in 5.2 the order of certain calls to plug-ins has changed. In order that metadata can 
contribute towards knob values in expressions, it has been necessary to calculate the knob 
values after the generation of the input tree. This means that split_input(), inputContext(), and 
uses_input() will be called before knobs have been stored with the call to knobs(), rather than 
after, as in 5.1. If split_input(), inputContext() and uses_input() themselves use any of the 
stored knob data, the plug-ins will need altering. There is a new knob flag, 
Knob::EARLY_STORE, that can be set on knobs to have them be stored at the earlier time. For 
example, the plug-in AppendClip (included in the examples) that uses "firstFrame" in its input-
Context() function has had
Int_knob( f, &firstFrame, "firstFrame", "First Frame");
changed to
Int_knob( f, &firstFrame, "firstFrame", "First Frame");
SetFlags(f, Knob::EARLY_STORE);
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The nukescripts folder has moved to the following location:

On Windows:

drive letter:\Program Files\Nuke5.2v1\plugins\nukescripts or

drive letter:\Program Files (x86)\Nuke5.2v1\plugins\nukescripts

On Mac OS X:
/Applications/Nuke5.2v1/Nuke5.2v1.app/Contents/MacOS/plugins/nukescripts

On Linux:
/usr/local/Nuke5.2v1/plugins/nukescripts

Please also see the Python changes on page 4 and page 12.
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